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Interfacing SmartFusion2 SoC FPGA with
DDR3 Memory through MDDR Controller

Introduction

This tutorial describes how to create a hardware design using the System Builder to access an external
DDR3 memory through the built-in hard ASIC MDDR controller in SmartFusion®2 system-on-chip (SoC) field
programmable gate array (FPGA) devices. This tutorial also shows how to functionally verify the design
using bus functional model (BFM) simulation. The SmartFusion2 SoC FPGA has up to two DDR controllers.
Those controllers are the microcontroller subsystem (MSS) DDR (MDDR) and fabric. DDR (FDDR)
controllers. The MDDR controller is a hard ASIC block in the SmartFusion2 SoC FPGA. The FDDR
controller is also a hard ASIC block which can be used to simplify the interfacing of different DDR memory
standards to the SmartFusion2 SoC FPGA fabric.

Note: The FDDR is not part of the MSS.

This design focuses on using the ARM® Cortex' -M3 processor as a master that talks to an external DDR3
SDRAM memory through the MDDR controller. The MDDR controller interfaces with the Cortex-M3

processor through the 64-bit AXI bus interface.
This tutorial describes the following:

ModelSim® Simulator

Tutorial Requirements

Creating a Libero® System-on-Chip (SoC) v11.5 project using the SmartFusion2 SoC FPGA
Configuring and generating the various hardware blocks and clocking system using the System Builder
Creating and generating testbench using the SmartDesign testbench Generator feature

Performing functional level verification of the design using AMBA® BFM simulation in MentorGraphics

Using the ModelSim GUI to see the various design signals in ModelSim Waveform window

This tutorial requires the following software and MSS core version installed on the PC:

Table 1. Tutorial Requirements and Details

Design Requirements Description

Software Requirements

Libero SoC v11.5

Microcontroller subsystem (MSS) v1.1.300

Hardware Requirements

Host PC or Laptop Any 64-bit Windows Operating System

Project Files

The associated solution and source project files along with the readme for this tutorial can be downloaded

from Microsemi® website:

http://soc.microsemi.com/download/rsc/?f=m2s_tu0372_ddr3_mddr_liberov11p5_df
Note: Extract the design files to the root directory. The Source_files folder includes the MDDR_wave.do,

user.bfm and the DDRS3 associated files.

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller
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Design Overview

Design Overview

The design demonstrates the read/write access to an external slave DDR3 memory using the SmartFusion2
SoC FPGA. Inside the SmartFusion2 SoC FPGA, the Cortex-M3 processor acts as the master and performs
the read/write transactions on the external slave memory. These read/write transactions between the
Cortex-M3 processor and the external DDR3 memory are executed through the DDR bridge and the MDDR
memory controller, which are part of the MSS.

The DDR bridge block is basically responsible for managing the read/write requests from the various
masters to the DDR controller in the MSS block. The DDR bridge also connects the AMBA high-
performance bus (AHB) based masters such as the Cortex-M3 processor to AXI based MDDR controller.

The MDDR controller interfaces with the DDR bridge through a 64-bit AMBA AXI interface and with the
external DDR3 memory through the SmartFusion2 SoC FPGA DDR 1/Os. The MDDR controller takes care
of converting the AXI transactions into the DDR3 memory read/write transactions with appropriate timing
generation. It also handles the appropriate command generation for write/read/refresh/precharge operations
required for DDR3 memory.

The MDDR contains two 64-bit AXI interfaces, one dedicated.to the DDR interface and the other to the
FPGA fabric. The MDDR can be used either to interface with the external DDR slave memory or to interface
with the FPGA fabric through the DDR_FIC interface. The DDR_FIC interface provides either a single 64-bit
AXl interface, one 32-bit AHB interface, or two 32-bit AHB interfaces to the. FPGA fabric.

The MDDR controller must be configured to match the external DDR memory specifications. In this tutorial it
is the DDRS3 specifications. The configuration of the MDDR can be defined in a file and the file can be
imported using the System Builder or using the DDR configurator. The configuration is done through the
CoreConfigP soft IP core which is the master of the configuration data initialization process. Upon reset, the
soft IP core CoreConfigP copies the data from embedded nonvolatile memory (eNVM) to the configuration
registers of the DDR through the FIC_2 advanced peripheral bus (APB) interface based on user specific
configurations. The RESET mechanism of the overall system is managed by the soft IP core CoreResetP.
The CoreConfigP notifies the CoreRestP when the register configuration phase is complete. The MSS
interfaces with the CoreConfigP IP core through the APB interface (FIC_2) to initialize the MDDR controller
registers based on a user specified configuration file. Refer to the CoreConfigP and CoreResetP handbooks
in the IP Catalog of the Libero SoC software for more information.

The purpose of this tutorial is'to demonstrate the interface of the MDDR with an external DDR slave memory
through the MSS. In this design,the System Builder is used to configure the system clocks and the MDDR
block to access the external DDR3 memory through the MSS through the DDR |/Os without going through
the fabric.

In the SmartFusion2 SoC FPGA device, there are six clock conditioning circuits (Fabric CCCs) inside the
fabric and one CCC (MSS CCC) block inside the MSS. Each of the CCC blocks has an associated PLL.
These CCC blocks and their PLLs provide many clock conditioning capabilities such as clock frequency
multiplication, clock division, phase shifting, and clock-to-output or clock-to-input delay canceling. The Fabric
CCC blocks inside the fabric can directly drive the global routing buffers inside the fabric, which provides a
very low skew. clock routing network throughout the FPGA fabric. In this design, the MSS CCC and fabric
CCC-blocks are configured using the System Builder to generate the clocks for the various elements inside
the MSS and the fabric respectively.

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller
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Step I: Creating a Libero SoC Project

Figure 1 shows the different blocks used in this design.

SmartFusion2 cSoC FPGA

Figure 1. -Level Block Diagram

Step I: Creating a Libero ject
The following steps describe create a Libero SoC project:
1. Launch Libero So
2.

From the Proje lect New Project. In the Project Details window, enter the information as

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller 5
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Step I: Creating a Libero SoC Project

G\ New Project =RR X

Project Details
Specify Project Details

Project Details

Project Name: DDR. 3_Smarh‘=usion2_Tub3riaI|
. . Project Location: E: /Microsemi_prj
Device Selection
Description:

Device Settings

Design Template Preferred HOL Type:

[ Enable Block Creation

Add HDL Sources

Add Constraints

. 2l
Libefo)

System-on-Chip

Figure 2. New Project Details Window
3. Click Next. In the Device Selection window; select the information displayed in Figure 3.
e Family: SmartFusion2
e Die: M2S090T
e Package: 484 FBGA
e Part Number: M2S090T-1FG484

6 Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller
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Step I: Creating a Libero SoC Project

G\ New Project = | B |
Device Selection
Select a part for your project from the Part Mumber list Selected Part: M25090T-1FG484
Part Filter
Project Detalls Fri racoge
Device Selection
Device Settings Search Part:
.EELLN.I.IEIDP" AL DEE Lser 10 LISE AN K LSEANM 13K Math (183 158) Pllgand d
Design Template M2S0S0T-1FG4B4  &6184 86184 267 12 109 8 6
TAZS090 T-TFGASaT BIeT BIeT 267 TT 09 a3 3
M23090T-1FG484 M 86184 86184 267 112 109 84 6
M25090T-FG484 ao184 86184 267 112 109 a4 6
Add HDL Sources M2S0SOT-FGA841 86184 86184 267 12 109 84 6
Add Constraints
Libefc')‘
System-on-Chip - ‘ = :
[=gak | [ mext> | [ Ensh | [ cancel
Figure 3. Device Selection Window
4. Click Next. In the Device Settings window, select the information displayed in Figure 4.
e Default I/O Technology: LVSMO2.5 V.
e PLL Supply Voltage (V): 2.5
e Maximum Core Voltage Rail Ramp Up Time: 100ms Minimum
e System Controller Suspend Mode: Unchecked
G\ Mew Project =NACE X

Device Settings

Project Details
Device Selection
Device Settings
Design Template
Add HDL Sources
Add Constraints

o 2l
Libefo®

SystemronChip

Choose Device Settings for your project

1O Settings

Default I/O Technology: LVCMOS 2.5V + a Please use the 1O Editor to change individual IO attributes.

Reserve Pins for Probes

Power Supplies

PLL Supply Voltage (V): 2.5 -

Maximum Core Voltage Ral Ramp Up Time:

[ System Controller Suspended Mode

Selected Part: M25090T-1FG484

[ < Back ][ Mext = ][ Finish ][ Cancel

Figure 4. Device Settings Window

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller



& Microsemi

Step I: Creating a Libero SoC Project

5. Click Next. In the Design Template page, select the Create a System Builder base design under the
Design Templates and Creators.

6. Click Finish.
7. Enter MDDR_system as the name of the system and click OK. , as shown in Figure 5.

- ]

X Spstern Builder @

Enter a name for your system:

MDDR._system|

QK ] [ Cancel

Figure 5. Create New System Builder Dialog Box
8. The System Builder dialog box is displayed with the Device Features page, as shown in Figure 6.

@ Systemn Builder - Device Features‘ .‘i .

> Device Features » > Memories »

Memaory I

M55 External Memory
@ MDDR
") Soft Memory Controller (SMC)
[ M55 0n-chip Flash Memory ( eMNvM )
FabhisExternal DDOR. Memory { FDDR )

High Speed Serial Interfaces

Microcontroller Options
[7] watchdog Timer
[7] Peripheral DMA
[7] Real Time Counter

|
I
I
1
1
|
I
1
1
|
I
1
1
1
|
I
1
1
1
|
!
[ SERDESIF O |
|
1
|
I
1
1
|
I
I
1
1
|
I
1
1
1
|
I
1
1
1

Figure 6. SmartFusion2 SoC FPGA System Builder Configurator
9. Under Memory, check MSS External Memory and select MDDR. Leave all other options unchecked.

10. Click Next, the System Builder — Memories page is displayed, as shown in Figure 7. The DDR3
external memory models are used in this tutorial.

¢ DDR memory settling time (us): 200

8 Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller
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Step I: Creating a Libero SoC Project

When you use an external memory model, you need to wait for the memory to initialize (settling time)
before you try to access it. Since you are using the DDR3 memory model, you need to wait at least
200us.

The DDR controller must be configured to match the external DDR3 memory specifications. The
configuration is done through the CoreConfigP soft IP core, which is the master of the configuration data
initialization process. Upon reset, the soft CoreConfigP copies the data from eNVM to the configuration
registers of the DDR controller through FIC_2 APB interface.

The System Builder enables you to import the register configuration file in which you defined the DDR
controller configurations. For this design a configuration file, DDR3_PHY_16_NO_ECC_BL8_INTER.txt, is
provided in the tutorial zip files. The configuration file is located under <project directory>\
DDR3_SmartFusion2_Tutoria\Source_files\DDR3 folder.

Import the register configuration file as follows:
¢ Click Import Configuration, as shown in Figure 7.

e The Import File window is displayed. Browse to the provided DDR3 configuration file
DDR3_PHY_16_NO_ECC_BLS8_INTER.txt and import it.

After importing the register configuration file, confirm the settings as follows:
e Memory Type: DDR3

e Data Width: 16

e SECDED Enabled ECC: Unchecked

[ @ Systern Builder - Memories - “ ’ ‘ :‘

> Device Features » > Memories » » Peripherals » »
Configur
{ MDDR.
DDR memory settling time (us): 200
[ImportCnnﬁguraﬁon ’ExportCnnﬁguraﬁun] ’F‘.estore Defaults]
General | Memary Initialization | Memary Timing |
Memory Setlings
Memory Type [DDRS hd ]
Data Width 18 -]
| SECDED Enabled ECC [~
Arbitration Scheme [Type—ﬂ v]
Highest Priority ID o
Address Mapping TROW, BAME, COLUMMNE
10 Drive Strength
@ Half Drive Strength ) Full Drive Strength
|

Figure 7. System Builder Configurator — Memory Page

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller 9
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Step I: Creating a Libero SoC Project

11. Select Next, System Builder- Select Peripherals page is displayed, as shown in Figure 8.
This tutorial does not use any of the MSS peripherals. Clear all the MSS Peripherals, as shown in
Figure 8.

Since the system is using an MSS DDR (on the first page of the System Builder), the MSS_DDR_RAM
is shown under the MSS DDR FIC Subsystem, as shown in Figure 8.

© Systern Builder - Peripherals = @

> Device Features Mermaries » » Peripherals » ¥ Clocks Microcontroller » Y SECDED Security » ¥ Interrupts Mermory Map »

Select the peripherals and masters for each subsystem

Fabric Slave Cores Subsystems

Core Version @ MES FIC {0 - MBS Master Subsystem
drag end drop here to add to subsystem

1 :
2 Corel2C 7.0.102

T P— 1015 MES FIC O - Fabric Master Subsystem
4 CoreGPIO 30120 drag end drop here to add to subsysterr
5 CoreTimer 11101 MBS A 1 - MBS Masher Subsystem
6 CorelARTapb 522 dreg end drop here to add to subsystem
7 CorePyit 41.106 -

. MESHIE 1 SFabre MasteniSubsystam
8 Fabric AMBA Slave 00102

drag and drop here to add to subsystern

Fabric Master Cores -

Core Version

Fabric AMBA hMaster 0.0102

Confiqure Enable

| | o i | |

To move a penpheral from one subsystem fo anothey drag it from ix present focation and drop i onfo e desr
You cannof drag and drap onfo ME5 Parpherale,

Masters are in bold and blue,

Help — Back Mext

Figure 8. System Builder Configurator — Select Peripherals Page

12.. Click Next. The System Builder- Clock Settings page is displayed, as shown in Figure 9. Select the
following options:

e System Clock: Set it to 100 MHz (default) and select Dedicated Input Pad from the drop-down list
e M3_CLK: 100 MHz
o MDDR Clocks: Select 3 from the drop-down menu to get an MDDR_CLK of 300 MHz.

Note: You can see the clock and the different blocks it drives by clicking the clock name shown in Blue
color. For example, click the MDDR_CLK shown in Figure 9 and the clock and the blocks that the
clock is driving are displayed on the right-side panel.

10 Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller
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Step I: Creating a Libero SoC Project

— Elg
@ ystembuider Cocs s il 0 Y T PIY =

> Device Features » > Memories » > Peripherals » } Clocks » »» Microcontroller » » SECDED »»y Security » » Interrupts » > Memory Map >

Configure clock requirements

Clock | Fabricccc | chip Osdilators

System Clock

100.00 MHz
Dedicated Input Pad -
Cortex-M3 and MSS Main Clodk
: M3 CLK = 100.00 MHz 100,000
MDDR Clocks
MDDR. CLK =M3 CLK= 300,000
| DDR/SMC FIC CLK =MDDR_CLK f [1 -

MS5 APB_0/1 Clocks

AFB 0 CLK =M3_CLK / 100.000
APE 1 CLK =M3_CLK [ 100.000
Fabric Interface Clocks
FIC 0 CLK =M3_CK/ [L -
AHBLite Bypass Mode
FIC 1 CLK =M3ClK/ [L -
{ AHBLite Bypass Mode
Fabric DDR Clocks
FDDR CLK = 100 MHz
FDDR SUBSYSTEM CLK =FDDR_CLK/ [1 -
(|
|
Hep > Next

Figure 9. System Builder Configurator < Clock Settings Page
13. Click Next, the System Builder - Microcontroller Options page is displayed.
e Leave all the default selections
14. Click Next, the System Builder - SECDED Options page is displayed.
e Leave all the default selections
15. Click Next, the System Builder - Security Options page is displayed.
e Leave all the default selections
16. Click Next, the System Builder - Interrupts Options page is displayed.
e Leave all the default selections
17. Click Next, the System Builder - Memory Map Options page is displayed.
e Leave all the default selections
18. Click Finish.
The System Builder generates the system based on the selected options.

The'System Builder block is created and added to Libero SoC project, as shown in Figure 10. The
CoreResetP and CoreConfigP cores are automatically instantiated and connected by the System
Builder. Refer to Opening System Builder Component as SmartDesign section on page 13 for more
information on how the blocks are connected in the System Builder component.

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller 11
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Step I: Creating a Libero SoC Project

Design Hierarchy & x | B3 MDDR_system & X | ¥
B BoEre XL QARG E ANDO
o~
4 e@ work

51 XTLOSC_FAB (osc_comps.wv)
1 XTLOSC (osc_comps.v)
E=§|_ RCOSC_1MHZ_FAB (asc_comps.v)

m

MDDR_system_sb 0
FAB_RESET_N  POWER_ON_RESET_N

1 RCOSC_1IMHZ (osc_comps.v) CLKO_PAD DDR_READY
E DEVRST_N MS5_READY
) MDDR system MDDR_PADS El@-- - ----- - p ETOR PATTS
MDDR_system_sh FAB_CCC_PINSE
INT_PINS &
o m 3 ?
Desig. | DesignHier. | StmuusHe | Catalog | Fies || L i r

Figure 10. SmartFusion2 SoC FPGA System Builder Generated System
19. Connect the pins as follows:
o Tie the FAB_RESET_ N to high by right-clicking and selecting Tie High.

This is an active low reset input that comes from the userdogic in the fabric. In this tutorial, as you are
not using this signal so you can tie it High.

e  Mark the output port POWER_ON_RESET_N as unused by right-clicking and selecting Mark
Unused.

e Mark the output port MSS_READY as unused by right-clicking and selecting Mark Unused.

e Mark the output port FAB_CCC_GLO as unused by right-clicking and selecting Mark Unused.

e  Mark the output port FAB_CCC_LOCK as unused by right-clicking and selecting Mark Unused.
e Mark the output port INIT_DONE as unused by right-clicking and selecting Mark Unused.

20. Generate the final system by clicking SmartDesign > Generate Component or by clicking Generate
Component & icon on the SmartDesign toolbar.

You can also right-click on the canvas and select Generate Component, as shown in Figure 11.

MDDR_system_sb 0

4B FAE_RESET N POWER_ON_RESET N X
CLKO_PAD DDR_READY [ X
DEWRST_N MSS_READY X

WMODH_PADS H@-==-======= pLHMODRE PADS |
FAB_CCC_PMNSE
FAB_CCC_GLO b 4
FAB_CCC_LOCK »
INMT_PINSE
INIT_DONE »

&

% Generate Component

EE Auto Connect
1 Connection Mode

Figure 11. SmartFusion2 SoC FPGA Generated Final System

After successful generation of the system, the message “Info: 'MDDR_system_top' was successfully
generated. Open datasheet for details” is displayed on the log window.

12 Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller
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Step I: Creating a Libero SoC Project

Opening System Builder Component as SmartDesign

Upon generation, the System Builder configures, connects, and generates the entire MDDR system
including all the required blocks such as the MSS, clocks, CoreConfigP, and CoreResetP.

The final System Builder generated system is shown in Figure 11. You can dive into that block to see the
individual blocks that make-up the entire design. To do so, open the System Builder generated block using
the SmartDesign. It enables you to check the internals of the overall design. To open the MDDR_system
using the SmartDesign, use the following steps:

1. Inthe Design Hierarchy, expand MDDR_system_top component.

2. Right-click the MDDR_system and select Open as SmartDesign, as shown in Figure 12.

Design Hierarchy g X
B
4 il work
E| XTLOSC_FAR (osc_comps.y)
E=f[ XTLOSC (osc_comps.v)
E=ﬂ_ RCOSC_1MHZ_FAB (osc_comps.v)
E| RCOSC_IMHZ (osc_comps.v)
4 [F%] MDDR_system
U] MDDR Sy ¢\ p< Root
Instantiate in MDDR. system
Open Component
Open as SmartDesign...
Open HOL File
| Check HDL File
. = __l Create /O Constraint from Mod

I
Create ViewDraw Symbol

Desig... Design Hier...
Create Testhench

Figure 12. Open as SmartDesign Option

The system is converted to a SmartDesign component and the message is displayed, as shown in Figure
13.

5| Information &J

ol Your design MDDR._system_sb' has been successfully converted to SmartDesign.
- /J

Figure 13. Successful Conversion of System Builder to a SmartDesign Message

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller 13
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Step I: Creating a Libero SoC Project

3. Click OK. The system is shown in the SmartDesign canvas, as shown in Figure 14.

CORERESETP_0
L@ RESET_N_MEF MES_HFVE READY
1 FIC_2_AFB_M_FRESET_N DOR_READY
[FAEFESET WA FOWER_ON_RESET_N RESET_N_F2
| I FAB RESET N E_RESET N v
RCOSC 25 BOMHEZ MDOR_DOR_AX]_S CORE RESET_NIP
g oo CLK,_BASE INT_DONE]
ROOSC_25 SONHZ_O2F| —— CONFIGT_DONE
P CONFIGZ_DONE.
SOFT_EXT_RESET_CUT
— SOFT_| - P20
| | SOFT_he RESET
l SYSRESET_POR i @ il SOFT_MDDR_DDR_AX]_S_CORE RESET K
o
DEVRST_M  POWER_OM RESET_M| EI
T ?T =]
= U'J:
5
ol §I
S
Wwizz 'EBDI
==l
(=Y =} =
BE | DS
ool @ ] fﬁlxlg‘gl
g et ninir
—_— | 3% | 888888 zo
CORECONFIGP_0 7 T,
wfz= [ 2l T]
| |
1
£2| | E
2:4
o
<9
Nlu'
o
s
i
=
cCe_o 5 é
CLFD D 8 CLHD_FAD GLO §,m'
LOGK] oL
1] 4
oo
'S
pr
MDDR_system_M55_0
- MCCC_CLK, BASE WES_RESET_N NEF
p MCCC_CLK BASE ALL LIOCK FEC_2 APS_M FRESET_M
— MES_RESET N _FZIM FiC.2 AFB_I FCLK| )
NE_RESET_N NDDR_FADSE! SR EE]
— MOOR_AFE 5 FRESET N
b MDDR_AFE S _FCLK
GF |

Figure 14. System Builder Generated System Opened in the SmartDesign

The System Builder is automatically instantiated and connected different blocks based on the different
options«hat you have selected in the different pages of the System Builder.

o SYSRESET_POR: It generates the power-on reset signal for the CoreResetP block.

o CORERESETP_0 (soft core): It is responsible for managing all the reset mechanism needed for the
system.

o FABOSC_0: It generates the clock source for the CoreResetP block.

e CCC_0: Itis used to generate the clock source for the MSS_CCC MCC_CLK_BASE reference. The
MSS_CCC, which is part of the MSS, gets the reference clock from the Fabric CCC (CCC_0).

o CORECONFIGP_0 (soft core): It manages the configuration aspect of the controller based on the
specified configuration file.

14 Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller
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Step 2: Generating the Testbench

Step 2: Generating the Testbench

The following steps describe how to create a testbench for the design using the SmartDesign Testbench

Generator:
1. Enable the SmartDesign simulation cores by selecting Simulation Mode check box in the Libero SoC

IP catalog, as shown in Figure 15. The IP catalog displays three simulation cores to drive the device
under test (DUT):

e  Clock_Generator

e Pulse_Generator

e Reset_Generator
Note: If they appear in italic, double-click to download the cores to your local vault.

Q - Simulation Mode g
-
Mame Version
4 (Clock & Management
iClock _Generator (101
Pulse_Generator 1.01
Reset_Generator 101
Description: Clock_Generator
Time Units in picoseconds
| Files I Stimulus Hiera .. | Design Hiera ... | Design ... | Catalog

Figure 15. Simulation Cores in Libero IP Catalog
Double-click the Create SmartDesign Testbench in the Libero Design Flow window, as shown in

Figure 16.

MDDR._system_top O Q | ﬁ'

2.

»

Tool o
[y 4 “F Create Design ‘E
Ly Syster Builder 8

[y &£ Configure MSS

B3 Create SmartDesign
Create HDL
|ﬁ Create SmartDesign Testbench |
Create HDL TestBench
& View/Configure Firmware Cores
4 » Verify Pre-Synthesized Design
B simulate s

|Files I Stimulus Hier... I Design Hier... Desig... Catalog

Figure 16. Opening SmartDesign Testbench
3. The Create New SmartDesign Testbench dialog box is displayed, as shown in Figure 17.

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller 15
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Step 2: Generating the Testbench

4. Enter MDDR_system_testbench in the Create New SmartDesign Testbench dialog box and click
OK.

P

7| Create Mew SmartDesign Testhench @

Mame:

MDDR_system_testbench |
Set as Active Stimulus

o) [t

Figure 17. Create New SmartDesign Testbench Dialog Box
5. The SmartDesign canvas is displayed with the MDDR_system_top_0 component instantiated, as shown
in Figure 18.

startPage [ | EE MDDR_system_top [] | &2 MDDR_system* | 74 MDDR _system_testhench* (] |

m

MDDR_system_top_0

CLKO PAD | MDDR PADSEH@
DEVRST_N

% %8 & VI & B

=

“«©

Figure 18. SmartDesign Testbench Canvas
6. Drag the Clock_Generator and Reset_Generator simulation cores from the IP catalog to the
MDDR_system, testbench SmartDesign canvas.

7+ Open the Reset_Generator configurator by double-clicking RESET_GEN_0 in the SmartDesign
canvas. Ensure that the following information, as shown in Figure 19, is set in the RESET_GEN_0

configurator and click OK:
e Level: ACTIVE LOW (default)
e  Programmable Delay (ns): 1000
The reset generator provides the reset pulse for the simulation.
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,
[, Configuring RESET_GEN_0 (RESET_GEN -... Lol o= e

Configuration

Level |ACTIVELOW -

Programmable Delay {(ns) 1000

Help

Figure 19. RESET_GEN Configuration
8. Open the Clock_Generator configurator by double-clicking the CLK_GEN_0 in the SmartDesign
canvas. Ensure that the following information, as shown in Figure 20, is set.in the CLK_GEN_0
configurator and click OK:
e  Clock Period (ps): 10000
e Duty Cycle (%): 50
The clock generator period is set to 10000 ps to generate this 100 MHz clock, as shown in Figure 9. The
System Clock 10000 ps equal is to 100 MHz.

- T
[F, Configuring CLK_GEN_0 (CLK_GE... (Fc = e
. &

A

Configuration

Clock Period {ps) 10000

Duty Cyde (%) '5|:|

Help a Ok ] [ Cancel

Figure 20. CLK_GEN Configuration
9. Import the provided DDR3 models into the Libero SoC project and instantiate those models into the
testbench that you created in the previous steps. The DDR3 model must be imported as Stimulus files
as follows:
e File > Import Files > HDL Stimulus Files. This opens the Import Files dialog box
e Select HDL Stimulus Files (*.vhd *.v) option from the Files of type, as shown in Figure 21.
e  Select the provided ddr3.v and the ddr3_parameters.v files and click Open, as shown in Figure 21.
The files are located under the <project directory>\DDR3_SmartFusion2_Tutorial\Source_files
\DDRS3_folder.
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@ Import Files L2 |
Look in: | E:WMicrosemi_prj\.. Source_files\DDR3 v] (<= I+ W @ '
Mame Size Type
4| ddr3.v 148 KB v File
{4 ddr3_parameters.v I5KB v File I
4| [ |
I File name: "ddr3.v" "ddr3_parameters.v" _peu
Files of type: [HDL Stimulus Files (*.vhdl *.vhd *.v) v] l Cancel ]
Convert EDN To HOL
y 4 N

Figure 21. Import the DDR3 Models as Stimulus Files

Verify that the files are imported correctly as stimulus files by checking under the Stimulus folder in the
Files tab, as shown in Figure 22.

[1 component
(7] constraint
7 coreconsale
B DDR3_SmartFusion2_Tutorial. prix
[1 designer
7 firmware
7 hdl
Cphy_synthesis
4[] simulation
' [7 smartgen
=3 stimulus
& BN ddr3.wv
{ E ddr3 parameters.v
[ synthesis
4[] tooldata
7 viewdraw

EIRc

I+

|Ca1ﬁlug || Design Hie... | Files | Desig... || Stimulus Hie...

Figure 22. Imported DDR3 in Stimulus Folder

When the file is imported as a Stimulus, the file is displayed in the Stimulus Hierarchy window, as
shown Figure 23.
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Stimulus Hierarchy I g X
Show: [ show Root Testbenches

4 il work

o. Q MDDR_system_testbench

4 L1 F

| Desig. .. I Design Hier... | Stimulus Hie... | Catalog I Files |

Figure 23. Stimulus Hierarchy Window
10. From the Stimulus Hierarchy window, drag the ddr3 file into'the MDDR_system_testbench canvas.
You are basically instantiating the DDR3 models into the testbench to emulate an external DDR3
memory. You are going to simulate the write and read from the DDR3 using the Cortex-M3 processor
as the master through the MDDR controller in the MSS. After you instantiate the DDR3, the canvas is
displayed, as shown in Figure 24.

ddr3_0

CLK_GEN 0 r!;t_n tdgs_n[1:0]0>
- - ¢
MDDR_system_top_0 g::;n
CLKO_PAD MDDRFADSE cs_n
DEVRST_N ras_n

g- cas_n

 RESET_GEN_O dm tdqs[1-0]

RESETL> ba[2:0]
Fw addr{13:0]
' da[15:0]
dgs[1:0]
dgs_n[1:0]
odt

#R

Figure 24. System Testbench Canvas with DDR3 Models Instantiated

The next step is:to connect all the blocks on the testbench canvas. There are two different ways to make the
connections. The first method is by using the Connection Mode option.

To use the Connection Mode method, change the SmartDesign to connection mode by clicking the
Connection Mode on the SmartDesign toolbar, as shown in Figure 25. The cursor changes from the normal
arrow shape to the connection mode icon shape. To make a connection in this mode, click the first pin and
drag-drop to the second pin that you want to connect.
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32

% StartPage

=)=

@),

:‘|Cnnnectinn Mode

M

Figure 25. Enabling the Connection Mode Option

The second method to connect is, by selecting the pins to be connected_together, right-click and select
Connect.

To select multiple pins to be connected, select a pin, hold down the CTRL key.while'selecting the other pins,
right-click the input source pin, and select Connect to connect all the pins together./In the same way, select

the input source pin, right-click, and select Disconnect to disconnect the signals already connected.

11. Using whichever connection method described above, make the following connections in the
SmartDesign canvas between the RESET_GEN_0, CLK_GN. 0 and the MDDR_system_top_0:

e From RESET_GEN_0: RESET to MDDR_system_top_0: DEVRST_N

e From CLK_GEN_0:CLK to MDDR_system_top_0:CLK0_PAD

12. Expand the MDDR_system_top_0: MDDR_PADS. Using whichever connection method described
above, make the following connections in‘the SmartDesign canvas between the MDDR_system_top_0

and the ddr3_0:

e Connect MDDR_DQS_TMATCH_0_IN to MDDR_DQS_TMATCH_0_OUT of the
MDDR_system_top_0 block.

e Connect the rest of the pins as shown in Table 2.

Table 2. DDR3 Pins Connections

MDDR_System_Top_0_Pins DDR3_0_Pins
MDDR_CAS_N cas n
MDDR_CKE cke
MDDR_CLK ck
MDDR_CLK_N ck_n
MDDR_CS_N cs_n
MDDR_ODT odt
MDDR_RAS_N ras_n
MDDR_RESET N rst_n
MDDR_WE_N we n
MDDR_BA[2:0] ba[2:0]
MDDR_DM_RDQSJ1:0] dm_tdqs[1:0]
MDDR_DQ[15:0] dq[15:0]
MDDR_DQS[1:0] dgs[1:0]
MDDR_DQS_NJ[1:0] dgs_n[1:0]
MDDR_ADDRJ[13:0] Addr[13:0]
MDDR_ADDR([15:14] Mark Unused

There are buses on the MDDR_system_top_0 and the ddr3_0 that do not match in width. To connect those
buses, you need to slice them first to create an equivalent bus width that matches between the
MDDR _system_top_0 and the ddr3_0.
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For example, the MDDR_ADDR [15:0] is a 16 bits bus while the addr[13:0] on ddr3_0 is a 14 bits bus. To
connect these two, MDDR_ADDR([15:0] needs to be sliced into two slices. The first slice is MDDR_ADDR
[13:0] and the second slice is MDDR_ADDR [15:14]. After doing the slicing, connect MDDR_ADDR [13:0] to
addr[13:0] and mark the MDDR_ADDR[15:14] as Unused.

To slice a bus, use the following steps:

¢ Right-click the bus and select Edit Slice, as shown in Figure 26. The dialog box is displayed, as shown in

Figure 27.

MDDR_system_top_0 ddr3_0
CLKO_PAD MDDR_PADSEH rst_n tdgs_n[1:0] -
DEVRST_N WDDR_DQS TMATCH 0_OUT ck

MDDR._CAS N ck_n
MDDR_CLK cke
MDDR_CLK_N cs_n
MDDR_CKE ras_n
MDDR_CS N cas_n
NDDR_ODT We. n
MDDR._RAS N dm_tdgs[1:0]
MDDR_RESET_N ba[2:0]
MDDR WE N addr[13:0]
-ﬂ_ Cc;ne-:t ]]
NDI:R—BA - Ei-‘--'cnne-'t ]]
MDDR._DQS TMATCH ( R 1:0]
M_W_H:)QS[ Dﬂ QuickConnect... Chrl+
NMDDR 1 g- Es
M

MDDR DQS[  Hidelet
MDDR_DOS N[ Rename Met...

Edit Slice...

Premiote ta Top Level

Figure 26. Creating a Bus Slice

e Click B icon (circled in Figure27) to'add a slice. Since you need to add two slices, click B icon twice.
Then add the slices, as shown in Figure 27.
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m Edit Slices - MDDR_ADDR[15:0] [2|[X]

Create V slices of width |1 w

MDDR_ADDR[15:0] [@» Left Right
13 0
2 15 14

T NET

Figure 27. Edit Slices Dialog'Box
e Click OK. This creates two slices of the MDDR_ADDR bus;as shown in Figure 28.

MDDR_system_top_0

3 CLKO_PAD MDDR_FADSE
DEVRST N  MDDR_DQOS_TMATCH 0_OUT

A
O
I;’i

MDDR_DOS_TMATCH 0_IN
MDDR_DM_RDGQS[1:0]
MDDR_DQ[15:0]
MDDR_DOS[1:0]
MDDR_DOS_N[1:0]

FE

Figure 28. MDDR_ADDR Created Slices
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13. Promote tdgs_n[1:0] of ddr3_0 instance to top by right-clicking on the pin and selecting Promote to
Top Level.

After making all the connections, the canvas is displayed, as shown in Figure 29.

MDDR_system_top 0

CLKD D LY
CB/RET_N WODR_DOS_TMAT

qu_rﬂ-nll &5 EEGRE )

S
-

w“
=

gggﬁ

3
g

s
Eml
8
g

:
;5
St

8
g
i
§

8
E%E

Figure 29. Fully Connected MDDR System

14. Generate the final system testbench by clicking SmartDesign> Generate Component or by clicking
Generate Component & icon on the SmartDesign toolbar. You can also right-click on the canvas and
select Generate Component.

On successful generation, the message “Info: 'MDDR-system_testbench' was successfully generated”
is displayed on the log window:

15. After generating the testbench, you need to make it Active testbench. By doing so, you are specifying
the testbench that should be used for simulation. To set the testbench as the active testbench, use the
following steps:

1. Go to the Stimulus Hierarchy tab

2. If not already set, right-click the MDDR_system_testbench and select Set as active
stimulus, as shown in Figure 30.

Stimulus Hierarchy

Shaow: Show Root Te:
4 il work

4 [# MDDR svstem testbench
Dpen Component

b B Setasactivestimulusl

Simulate Pre-Synth Design 4

Open HDL File
L] Check HDL File

Catalog Fil P s TTT Stimulus Hierarchy

Malata Framm Micl amAd Denizrt

Figure 30. Setting a testbench as Active testbench

Step 3: Modifying the BFM Scripts

The following steps describe how to modify the BFM script (user.bfm) file that is generated by the
SmartDesign. The BFM script file simulates Cortex-M3 processor writing to /reading from the DDR3 model
through the MDDR.
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1. Open the user.bfm file. To open the user.bfm, go to the Files tab > Simulation folder, double-click the
user.bfm. The user.bfm file is shown, as shown in Figure 31.

.
e E MDDR_system_top E MDDR_system™ Q MDDR_system_testbench | user.bfm @ | 4

[ constraint ~ .
D coreconsole . . - 2 # Enter your BFM commands in this file.
B DDR3_SmartFusion2_Tutorial.prix 33
[0 designer 4 # Syntax:
[ firmware 53 o
[ hdl 6 3
[ phy_synthesis 7 # memmap resource_name base_address;
=[] simulation 8 2
B bfmtovec.exe 9 # write width resource_name byte_cffset data;
B CompileDssBfm.tcl 10 # read width resource_name byte_offset;
MDDR. init.bfm 11 # readcheck width resocurce_name byte_ocffset data;
. 2:
13 #

peripheral_init.bfm

B

B modelsim.ini
B

B subsystem.bfm

15 include "subsystem.bfm™

B test.bfm -
Bt 17 procedure user main;
[ smartgen 18 -
= [ stimulus 19 # perform subsystem initialization routine
B ddr3.wv 20  call subsystem init;
B ddr3_parameters.v 21
3 synthesis 22 2 gdd your BFM commands below:
[7 tooldata 23
[ viewdraw = 24 return
Catalog Design Hie... | Files | Desig... Stimulus Hie...

Figure 31. SmartDesign Generated user.bfm File
2. Modify the user.bfm to add the following bfm commands of writing and reading and click Save.

# add your BFM commands below:

# DDR memory map
al memmap M MDDRO_SPACE 0 0xA0000000;

print "TEST STARTS";

bl#write different values to different location

write w M_MDDRO_SPACE 0/0x0000 OxA1B2C3D4;
write w M_MDDRO_SPACE 0 0x0004 0x10100101;
write w M _MDDRO SPACE .0 0x0008 0xD7D7E1El;
write w M _MDDRO SPACE_0 0x000C OxASDEF6E7;
write w M MDDRO_SPACE 0 0x0010 OxABCDEFO1;
write w M_MDDRO SPACE 0 0x0014 O0xCCBBAADD;

#read check!/ what you wrote in step#b above
readcheck w M _MDDRO_SPACE 0 0x0000 OxAlB2C3D4;
readcheck w M_MDDRO_SPACE_0 0x0004 0x10100101;
readcheck w M _MDDRO_SPACE_0 0x0008 OxD7D7E1EL;
readcheck w M _MDDRO_SPACE_0 0x000C OxAS5DEF6E7;
readcheck w M MDDRO SPACE 0 0x0010 OxABCDEFO01;
readcheck w M MDDRO SPACE 0O 0x0014 OxCCBBAADD;

Q

print "TEST ENDS";

Note: An updated user.bfm file is included in the source files folder (<project directory>\
DDR3_SmartFusion2_Tutorial\Source_files). You can import this file instead of manually modifying
the user.bfm file as follows:

e Go to Files tab and right-click on the simulation Folder as shown in Figure 32.
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> [ component &

[ censtraint

> [ designer

B[] firrmware
[ _hdl

4 ||:| sirmulatiog

bfirntovec

m

Import Files...

rADDR_init.bfim
MDODR_systern_testbench_presynth_simulati.. —

rmodelsir.ini
rmodelsirm.ini.sav
peripheral_init.bfrm
presynth

run.do

-

— PP P [ P [P [P [P [P

subsystem.bfrn

Ak . L

-

Desig...

Design Hier.. | StmuusHiel. | Catalog|| Fies |

Figure 32. Importing bfm Source File
¢ Browse to <project directory>\DDR3_SmartFusion2_Tutorial\Source_files and select user.bfm and
select Open.
e A warning message is displayed, as shown in Figure 33.Click Yes.

F l
1| Warning ﬁ

W A

5. < The file:'simulation\user.bfm' already exists,
/ Are you sure you want to replace it?

L

tes || vestodl |[ Mo || Notoal

N

Figure 33. Replacing Existing user.bfm File

s A warning message is displayed as shown in Figure 34 if the user.bfm file is already opened in
your Libero window. Click Yes. If the user.bfm is not opened already in your Libero window, the
message does not show up.

rEl Warning b ﬁ"

The file:'D: \Microsemipri\DDR.3_SmartFusion2_Tutorial\simulationuser.bfm' has been modified outside of the Libero Text Editor,
JA Do you want to reload it?

[ fes ][ Yes to Al ][ Mo H Mo to Al

Figure 34. Reloading and Updating user.bfm File
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The following is an explanation for the different steps that you added into the bfm above.

e Step a: In this step you are specifying the base address at which the MDDR is located. In this case it is
0xA0000000

o Step b: In this step you are writing different values to different locations. For example,
write w M_MDDRO_SPACE_0 0x0000 0xA1B2C3D4;
‘ A

Offset from base address Data to write

Writing a word

Base address

¢ Step c: In this step you are checking what you wrote. The final user.bfm is displayed, as shown in

Figure 35.
userbfm [£J
21
22 # add your BFM commands below:
23
24

25 # step a: DOR memory map
26 memmap M MDDRO SPACE O O0xR0O000000;
27 print "TEST STARTS";

28

29

30 #3tep b: write different waldes to different location
31 write w M_MDDRO_SFACE 0 0x0000 OxR1B2C3D4:

32 write w M_MDDRO_SPACE 0 0x000470x10100101;

33 write w M_MDDRO_SPACE @ 0x0008 OxDTD7ELELl;

34 write w M MDDRO SPACE 0 Qr000C OxRSDEFGET;

35 write w M MDDORO SPRCE(D 0x0010 OxRBCDEFO1;

36 write w M MDDROSSPRCE/ 0 0x0014 OxCCEBRADD;

37

38

39 #3tep £: read check what vou wrote in step "b' abowve
40 réadcheck w M/MDDRO SPRCE 0 0x0000 OxR1B2C3D4;
41 rezdcheck w M MDDRO SPRACE 0 0x0004 0x10100101;
42 rezdcheck w MOMDDRO SPACE 0 0x0008 O0xDTDTELEL;
493 readcheck w M MDDRO SPRCE 0 Ox000C OxRSDEFEET;
44 readeheck w M MDDRO SPRCE 0 0Ox0010 OxRBCDEFOL;
45 readcheck w M MDDRO SPRCE 0 0Ox0014 OxCCEBRADD;
45

47

438 print "TEST ENDS™:

49

a0 return

Figure 35. user.bfm after Adding the Commands

Refer to DirectCore Advanced Microcontroller Bus Architecture — Bus Functional Model User Guide for more
details.
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Step 4: Simulating the Design

The following steps describe how to simulate the design using the SmartDesign testbench and BFM script
files:

1. Navigate to Project > Project Settings to open the Libero SoC project settings .

2. Select Do File under Simulation Options in the Project Settings window. Change the Simulation
runtime to 260us, as shown in Figure 36.

G‘ Project Settings

Device Selection

Device Settings

Design Flow Simulation runtime: 260us

Analysis Operating Conditions
4 Simulation Options

Use automatic DO file

Testbench module name:  MDDR_system_testbench

DO File Top level instance name:  <top>_0
Wavef

E_w orms [7] Generate vcD file
Vsim commands

4 Simulation Libraries VCD file name: power,vad
SmartFusion2 V.

[T verilog 2001
[ system Verilog

[] vHDL2008

User defined DO file:

DQ command parameters:

Figure 36. Project Setting — Do File Simulation Runtime Setting
3. Select Waveforms under Simulation Options:

e Select Include DO file, browse to where you extracted the provided source files, and select
MDDR_wave.do file, as shown in Figure 37. In this file, the list of signals that are required is already
selected so you can check for the expected results.

e Select Log all signals in the design.
e Click Close to close the Project settings dialog box.
e Select Save when prompted to save the changes.

Note: The path is modified to use ${PROJECT_DIR} so that the path is always relative to the project
directory.
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G\ Project Settings

Dev!ce Sele.ctmn Indude DO fle
Device Settings
Design Flow S{PROJECT_DIR}/.. .. /Source_files/MDDR _wave.do

Analysis Operating Conditions
4 Simulation Options Display waveforms for [top_level MDDR._system_testbench
DO File
Waveforms
Vsim commands
4 Simulation Libraries
SmartFusion2

[ 7] Log all signals in the design

Figure 37. Project Setting — Specifying the MDDR_wave.do File Location

4. Expand Verify Pre-Synthesized Design in the Design Flow window, as shown in Figure 38.
Double-click Simulate to launch ModelSim in GUI mode.

Design Flow

MDDR._system_tap B © |4 @'
s

Toaol
(T4 = b Create Design
s System Builder
Ty - & Configure MSS

B create SmartDesign
Create HDL
=+ Create SmartDesign Testbench
Create HDL TestBench
¢ View/Configure Firmware Cores

(= Ver'ﬁ Pre—Sinthesized I}esiin

= # Constrain Design
Import IfO Constraints
Import Timing Constraints
= ¢ Implement Design
% Synthesize
7 Constraints hd

| Catalog || Design Hierarchy || Files | Design Flow Stimulus Hierarchy |

Figure 38. Starting Pre-Synthesis Simulation
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Step 5: Valldatlng the Simulation Results

ModelSim runs the design for about 260 us, as specified in the Project Settings window.

It initializes the MDDR by writing a specific set of configuration options to the configurations registers.
Once the configurations are written to the registers, then you can write to the DDR3 memory. The
results are checked by the readcheck command. The external DDR3 memory must initialize before it
can be used. This is done by adding the 200us as specified in the System Builder- Memory page, as
shown in Figure 7. You can write and read from the external DDR.

2.  The ModelSim transcript window displays the BFM commands and the BFM simulation completed with
no errors, as shown in Figure 39. Scroll in the window to see the different commands. In the BFM script
provided in the user.bfm earlier, the readcheck command reads the data and verifies if the data read
matches with the value provided along with the readcheck command. If the value read does not match,
the simulation shows an error.

— —
T - - -

‘ﬁl IJ:A‘_. :ﬂl.ﬂ ATAU GQUUUUULY GULUGUTLUL IMRJdfie 1112121212312 —— - _ ﬁgi

# MONAXIO: #4440 4000444 N

# MONAXIO: RCMD & ID:1 SEQ:6 ADDR:al000010 BURST:1 LEN:0 5IZE:3 LOCK:0 at 233714647 ps

# MONDDRC: READ REQUEST SEQ:6& TOKEN:d ADDR:a0000002 LEN:1 at 233724647 ps

# MDDE_system testbench.ddr3 O.cmd task: at time 233741524 ps INFO: Read bank 0 col 008, aute prechacge 0

# MDDR_system testbench.ddr3 0.data_task: at time 233759857 ps INFO: READ @ DQS= bank = 0 row = 0000, 26l = 000000028 data = efll

# MDDR_system teatbench.ddr3_0O.data_task: at time 233761524 pa INFO: READ @ DQS= bank = 0 row = 0000 ccl = 00000009 data = abed

# MDDR_system testbench.ddr3 0.data_task: at time 233763190 ps INFO: READ @ DQS= bank = 076w = 0000 col =0000000a data = aadd

# MDDR_system testbench.ddr3 0.data_task: at time 233764857 ps INFO: READ @ DQS= bank # 0 row = 0000 col = 0000000k data = cckb

# MDDR_system testbench.ddr3 0.data_task: at time 233766524 ps INFO: READ @ DQS= bank = 0 row = 0000 col = 0000000c data = XKXX

# MDDR_system testbench.ddr3 0.data_task: at time 233768190 ps INFO: READ @ DQS= bank = 0 row = 0000 col = 0000000d data = XXXX

# MDDR_system testbench.ddr3 0.data_task: at time 233769357 ps IN @ DQS= bank = O row = 0000 col = 0000000e data = XKXX

# MDDR_system testbench.ddr3 0.data_task: at time 233771524 ps INFO: READ @ DRS= bamk = 0 row = 0000 col = 0000000f data = XXXX

# MONAXIO: RDAT Start ID:1 SEQ:6& - matching RCMD:& ADDR:al000010 BURST:1 LEN:0 5SIZE:XS &t 1786413 pa

# MONAXIO: RDAT ID:1 ccbbaaddabcdef(l at 233787980 ps

# MONAXIO: QUEUED O per ID=000000000000000O0CHMDS=0000

# MONDDRC: RESF START TOKEN:d Request SEQ:& ADDR:a0000002 LEN:1 from 1796413 ps

# MONDDRC: RESP DATR TOKEN:d DATA:cchbaaddabedef0l End:0 at 233787880003

# MONDDRC: RESF DATA TOEEN:d DATA:MXXXENENNXNEENXNX End:1 at 233784547 p3

# MONDDRC: QUEUED CMDS O

# BFM: Data Read al000014 ccbbaadd MRSK:Ifff: ff at 233804.646912ns

## RAAEAARRRRRRRRRRFRRRRRGERRARR SR RAARR AR AR AR ]

#

#|BFM Simulation Complete - 5202 Instructicns - NO ERRCRS

&

FHEHHHR R R R

#

# MDDR_system testbench.ddr3 0O.cmd task: at time 234038190 ps INFO» Frecharge bank 0 —

# MDDR_system testbench.ddr3 0O.cmd task: at time 2340648564ps INFO: Precharge Power Down Enter _:J

MNow: 260 us Delta: 2 tdgs_n 259976922374 fs to 2600012148

Figure 39. ModelSim BFM Simulation Transcript Results

Once the simulation is run completely, undock the Wave window. The Wave window can be undocked by
clicking the Dock/Undock-icon on the Wave window, as shown in Figure 40.

[T wave - Default

Figure 40. Doc or Undock of ModelSim Wave Window

3. Once the Wave window is undocked, click the Zoom Full icon as shown in Figure 41 to fit all the
waveforms in the single view.

[T wave - Default

Figure 41. Zoom Full Option

4. Place the cursor around 233 ps on the Wave window and click the Zoom In on the Active Cursor icon
as shown in Figure 42, to zoom in at that location. That shows the time at which the data was
written/read-back to/from the DDR3 external modules, as shown in Figure 43.
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Conclusion
Figure 42. Zoom In on Active Cursor Button
Figure 43 shows the time at which the data was written/read-back to/from the DDR3 external modules.
That concludes this tutorial.
8| Wave =) [
File Edit View Add Format Tools Bookmarks Window Help
g8 Wave -Default — e x]

B-FE 8 shBOo2 oMLt 4ns| 4 408 3| SHHRA||x-€ 3 e

|[Tam
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Figure 43. Write/Read Data
5. Quit the ModelSim simulator by selecting File > Quit.

Conclusion

In this tutorial, you created a new project in Libero SoC, configured the MDDR system using the System
Builder to access an external DDR3 SDRAM memory through MDDR controller with the Cortex-M3
processor as master, created a testbench using the SmartDesign testbench generator, and connected the
different blocks using the SmartDesign tools.

The design in ModelSim using AMBA BFM simulation is verified.

Appendix A: VHDL Flow

If you are designing with VHDL, since the DDR3 memory models used here are in Verilog, you need to use
the ModelSim full. version (for example, ModelSim SE) instead of ModelSim AE. ModelSim AE does not
support mixed-language flows. Use the following steps to simulate VHDL design:

1. Copy the precompiled VHDL simulation library folder smartfusion2 from the Libero SoC install area
(<Libero install> \Designen\lib\modelsim\precompiled\vhd|\) to a different folder on your disk (for
example, E:\Microsemi_prj\)

2. Remove the Read-Only attribute from the smartfusion2 folder at the new location.

Note: The reason for steps 1 and 2 is that ModelSim full version needs to refresh the precompiled
library. Those steps are to enable ModelSim full version to refresh the precompiled library and to
ensure that the original precompiled library, which is installed with the Libero SoC, is unchanged.

3. Simulate with automatic design optimization option disabled (-novopt) and point to the new precompiled
library location (for example, E:\Microsemi_prj\smartfusion2) in the Project Settings window as shown
below:

(a) Select Project Settings from the Project menu

(b) Select Vsim commands under Simulation Options. Add the —novopt option into the Additional
options field, as shown in Figure 44. The —novopt option disables the automatic design
optimization run.
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Appendix A: VHDL Flow

(?‘ Project Settings

Device Selection SDF Timing Delays

Device Settings
Design Flow Minimum Disable Pulse Filtering
Analysis Operating Cenditions Typical during SDF based Simulations
4 Simulation Options
DO File @ Maximum

Waveforms

A Syt orare Additional options:  -novept
SmartFusion2

Help

Figure 44. Project Settings — Specifying —novopt Simulation Option
(c) Select SmartFusion2 under the Simulation Libraries

I.  Inthe Library path, enter the newlocation where you copied the precompiled library (for
example, E:/Microsemi_prj/smartfusion2), as shown in Figure 45.

G‘ Project Settings

Device Selection
Device Settings
Design Flow
Analysis Operating Conditions
4 Simulation Options
DO File
Waveforms
Vsim commanids,

Library path: E: Microsemi_prifsmartfusion2

Help

Figure 45. Project Settings — Specifying Precompiled Library Path
(d) Click Save to save the project settings and click Close to close the Project Settings window.
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Appendix B: Abbreviation Used

Appendix B: Abbreviation Used

e ¢SoC — customizable system-on-chip
e MSS — Microcontroller subsystem
¢ DDR3 SDRAM — Double data rate synchronous dynamic Random Access Memory
e CCC - Clock conditioning circuitry
e MSS CCC — CCC block inside the MSS component
e Fabric CCC - CCC block instantiated inside the FPGA fabric
e DDR — Dual data rate memory controller
e MDDR - DDR controller inside the MSS component.
¢ BFM — Bus functional model
e FIC — MSS fabric interface
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Product Support

Microsemi SoC Products Group backs its products with various support services, including Customer
Service, Customer Technical Support Center, a website, electronic mail, and worldwide sales offices. This
appendix contains information about contacting Microsemi SoC Products Group and using these support
services.

Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

From North America, call 800.262.1060

From the rest of the world, call 650.318.4460

Fax, from anywhere in the world 408.643.6913

Customer Technical Support Center

Microsemi SoC Products Group staffs its Customer Technical Support Center with highly skilled engineers
who can help answer your hardware, software, and design‘questions about Microsemi SoC Products. The
Customer Technical Support Center spends a great deal of time creating application notes, answers to
common design cycle questions, documentation of known.issues and various FAQs. So, before you contact
us, please visit our online resources. It is very likely we have already answered your questions.

Technical Support

For Microsemi SoC Products Support, visit
http://www.microsemi.com/products/fpga-soc/designsupport/fpga-soc-support

Website

You can browse a variety of technical and non-technical information on the Microsemi SoC Products Group
home page, at http://www.microsemi.com/soc/.

Contacting,the Customer Technical Support Center

Highly skilled engineers staff the Technical Support Center. The Technical Support Center can be contacted
by @mail or through the Microsemi SoC Products Group website.

Email

You can communicate your technical questions to our email address and receive answers back by email,
fax, or phone. Also, if you have design problems, you can email your design files to receive assistance. We
constantly monitor the email account throughout the day. When sending your request to us, please be sure
to include your full name, company name, and your contact information for efficient processing of your
request.

The technical support email address is soc_tech@microsemi.com.

My Cases

Microsemi SoC Products Group customers may submit and track technical cases online by going to My
Cases.
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ITAR Technical Support

Outside the U.S.

Customers needing assistance outside the US time zones can either contact technical support via email
(soc_tech@microsemi.com) or contact a local sales office. Sales office listings can be found at
www.microsemi.com/soc/company/contact/default.aspx.

ITAR Technical Support

For technical support on RH and RT FPGAs that are regulated by International Traffic in Arms Regulations
(ITAR), contact us via soc_tech_itar@microsemi.com. Alternatively, within My Cases, select Yes in the ITAR
drop-down list. For a complete list of ITAR-regulated Microsemi FPGAs, visit:the ITAR web page.
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